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1) 
. . 

In KompoZer, which of the foBowing options is used_ to 
. add Selection Hst? 

. . . 

{A) Insert ➔ . Selection List 
(B) Form ➔ · Selection List 

. (C) File , ➔ Sel�ction List 
(D) Edit ➔. S�lection.List .

2) · Whichtoolbar is used to give Heading-I styleto the heading
of the form? 

· · 

(A) Format Toolbar-1
(C) Composition Toolbar

(B) Format Toolbar-2
. (D) Status Bar

3) When we click ·on any item in the page, in_ which of the
following its structure appears?
(A) Compo�itio11 Toolbar _(B) Format Toolbar-1
(C) · Status Bar · · (D) Format Toolbar-2

. 4) · · Which attribute is used to specify where to send the fr>rm 
· data when the forrti is submitted and what will be. the valu�.
ofit?

· (A) Method, Get
· (C) ·_ Action, Get
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(B). Method, Post 
(D) Action, File name .
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5) Whi�h type of input element will convert typed characters
:.into non readable format?

6) 

7) 

8) 

(A) Password
(C) Text

(B) - Check box
(D) Reset

Which of the following will show a blank untitled-web page_ 
� in KompoZer? 

(A) Edit mode toolbar
_·. (C) Site manager 

(B) Format toolbar-1
(D) Page pane

What should remain same_ for an possible answers while 
creating radio button?· 
(A) Field value __ · _ -. (B) _ Group name
(C) Field,selected option (D) Initially selected option

In KompoZer window, which tab of E<;lit Mode Toolbar 
should be.dicked to view source code of recently created 
form? 
(A) Design
(C) Source

(B) · Preview
(D) Normal

. 9) · While creating CSS-,_which button should be clicked to select
- the file for the background, if we want to keep an image in
the background?

. (A) Opacity (B) Position _-
- (C) Tile , (D) Choose File

. . . 

10) Which of the following makes website designing quick and
efficient?
(A) JavaScript (B) CSS
(C) ijTML · (D) _Java

11) In the syntax ofCSS, in Declaration, which of the folle>wing
- is/ are included?

· · · · 

(A) HTML element
(B) Property asso_ciated with the HTML element
(C) Corresponding v_alues of properties ·
(D) Both (B) and (C)
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12) _ After using which optic:>n, a web page no longer:remains
static, but can include ·coding that allows interactivity with
the user, controlthe browser and dynamically create HTML __ 

· ·content?
(A) JavaScript
(C) .HTML

(B) - CSS
·(D) _ KompoZer

13) Which of the follqWing statements is /�re·true for JavaScript?
(i) . JavaScript is used'for validation of client side users _
(ii) Can describe the style of the elements ·in document

not the content
(iii)- After using h, web page no longer remain,s static 

: (A) ·Only(iii) - (B) _Only(ii)and(iii) 
. (C) Only(i) and (iii) (D) Al

J

(i), (ii) and (iii) . 
. _· . . , . . . . . I .  . . . 

-14) Which event would occur when elemeqf such as button_ 
becomes active? 
(;\) select 
(C) click.

(B) focus
., . (D) mouseover

.15)_ Which of the following is an event handler of 'submit' event? · · 
. . . . 

; 
. 

(A) S\lbmit{) (B) function submit (),
(C) - onsubmit( ) (D). onclick ()

16) ln Browser Object Model, in which object, �Uthe elements·
of the web page like fonns, images, links and others are

· included?
. (A) - Location
• (C) .Parerit

(8) · History.
(D) Document

17) : Which of the following will b_e .executed by an event or
when it is called inside a source code?
(A) Function (B) Variable
(C) · Event . _ (D) ·If statement 

18) Which·,of the following state,tne11ts will stop the function_
from executing arid return the specified value?
(A) Return statement (B} If statement 
(C) Event handler - (D) - All (A), (B), (C)
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19) · Which of the following ·plays a.very important role in a
business now-a�days, which helps in promoting the business, .
-selling_ the products and attracting a large .number of
customers?
(A) . KompoZer

· . (C) JavaScript
(B) Website
(D) HTML·

. . . � .. . . . . :,� 

20} Which kind ofirifonnation, awebsite should include? 

21) 

22) 

23) 

. . . 

(A) In English language and translated in other language
(B) Qerieraland detailed .
(C) · Complete am:i relevant .
(D) Both (B) and (C) ..

In Table Properties dialog box, which option· is used to 
specify gap between cells? 

. .  

(A) Size . (B) TableAlignrrient
· (C). Spacing (D) Padding

What should .be provided·, if we transfe•r the web pages
from our computer to the web host via FTP?
(A) Name of the website

. (B) Number oftotalpages
(C) User name and password ·
(D) Value of method attribute

Which. open source editor is an intuitive application that 
provides web developers with a simple use.r interface, which 
allows them to create websites without requiring indepth 

· technical knowledge?
(A) Amaya
(C) Aptana.Studio ·

· (B) BlueGriffon
(D) KompoZer

24) Which of the following_OpenSource IDE is used to create
projects in PHP, Rails, Ruby or Web? ..
(A) HTML (B) BlueGriffon
(C) Amaya (D) Aptana Studio
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·· · 25) Which option is used to create link in the website? . ·
. . ' 

-......__ . 

· {A) Insert➔ Link · (B) File ➔ Publish 
. (C). Insert➔ Hyperlink ·. (D) File➔ Upload

26) Which ofthe foll_owing kind of content provides users with
.. the detail.ed informati_on on the site like productsand services

description? 

27) 

. 28) 

· (A) Relevant .. 

· ( C) With prope_r layout . 
{B) · General 
(D) betaileq

Which ofthe followihg applicationofE�commerce includes
an example like the website wwwXrctc_.co.in of Indian ·
railways?
(A) Online Auctions · • (B) Marketing and Selling ·

· (C) · Information Services .··. · (D) . Support Services ·

In which. kind of business, customers ·can browsethrough 
prod�cts catalogue and available offers? 

. . 

· (A) Traditional·Commerce. (B) · E-Commerce ·
(C) L-Commerce · (D) All (A),{B): (C)

. ' 

29) Which oftlie following is a limitation of E-commerce?
(A). Resistance tochange (B) Lower cost

·. (C) Team wotk ·.· (D) Cond�ct business24x7

30) · Whichofthe following kind of websites provides information
reg�rding various government departmerits,_various welfare
schemes, differept �pplic.ation forms to be used. by \he
citizens etc?

_(A) G2B 
(C) G2C.

. (B) G2G 
(D) B2C

31) Which of.the, following business model allows more
. transparency among the, business entities-involved and results

· in more efficiency?
. (A) C2C
(C) B2C
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(B) ·C2B. 
(D) B2B
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32) Which of the following business model is the· type of
E-commerce that the consumers are most likely to see on
internet?
(A) C2B
(C) C2C

. (B) B2B 
. (D) B2C . 

33) Which of the following is an example ofGovermnent to
· Busine�s(G2B), business model?
(A) www.irctc.co.in

f.(' . . . 

(B) · wwwjnconietaxindia.gov.in
( C) tradeindia:com
(D) amazon.com

34) .Which of the following security aspect of E-Commerce I
M-:conunerce protects the data from private attacks?

35) 

3,6) 

(A) Confidentiality . . . (B) Integrity · 
(C) Authorization (D) Non-repudiation 

Which of the following are data centers which perform the 
· credit card transactions and manage funds. for the

merchants?
(A) IssuingBank ,.
(C) Processors

(B) Acquiring Bank · 
(D) Payment Gateway 

By using which of the following cards, all the transactions 
· will·be processed within India so th� cost wi!l be reduced?
(A) Master Card · (B) Visa·Card ·
(C) E-wallet (D) RuPay

3 7) By using which technique, the. attacker tries to· assume the 
identity of another ·person or system for transacting with 
victim site? 
(A) Sniffing (B) Spoofing 
(C) · Malicious code (D) Cyber vandalism

38) Which of the following secu�ity measures ensures that the
company is not accessed by the intruders?
(A)· Firewall (B) Digital Certificate 
(C) Cryptography (D) Copyright
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. 39) Targeted ads,promotional messag�s,customer-identification. 
on a store etc. are applications of which of the followirig 
location based services? 
(A) Information or directory services
(B) Advertising promotion
(C) E01,ergency services
(D) · Tracking services·

40) In the syntax of attribute declaration in UMLnotaiion': which_
pair bracketvalues, users are supposed to specify? ..
(A) {}

(C) <>

(B) []

(D} ()

· 41) Which are thi t�o core eiements for any .compu�er program? ·
(A) Function and :Method · 

·
. (B) · Data and Layo�t

42) 

· . 43)

. . 

. (C) Layout and Method (D) Data and Function 

'Teacheris a kind ofperson' is an example of which ofthe 
following options? 
(A) Aggregation ·
(C) 'Data.Abstraction

. .  · 

(B) Inheritance
. (D) Encapsula�io� 

What is called,the capability of using same names to mean 
differentthin•gs ih different contexts? 
·(A) Overloading · (B) Overridden

· (C) Layout (D) Messaging ·

44) Which of the following is a gene�al cori.c.ept used to embody
all the common features of a particular set of objects?

45) 

.-

. (A)· Procedures (B) · Polymorphism
(C) Data field (D) Class

To identify the objects, we use the values ofthese attributes, 
these values are called what? 
(A) Data field
(C) State

(B). Layout 
(D) Method.
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46) By using which kind of programming language, flexibility is:·
gained by being able to change o·r replace modules without
disturbing.other parts .of code?
(A) Procedural prog�amming
(B) Higher.level programming language
(C) Object-Oriented programming language> ·.
(D) . 'C' programming language

4 7) In whfoh of the following, the clas:s that forms part of the .. 
· owner class can exist independently and the life of an object
of the part class•i_s not det�rmined by the owrier class?
(A) Inh�ritance (B) Aggregation
(C) Polymorphism·· (D) Data-Abstraction

48) If the con�itional ternary is next·= (No/o 2 = :___ 0)?(N / 2) .: .
(3*N+J ); where N = 7then what will be the value of va_riable 

49) 

. next? 
(A) 22.
(C) ·3.5

. (B) 7 
(D) 0

In switch statement, if no match is found between test 
. .· . . . 

. 

expression and case values, then which statement will be . · 
executed? 

. -(A) break 
(C) ·if ... else

(B) continue .
{D) · default 

50) When a variable is declared inside a b·lock, what'is it called?
(A) . Global (B) Local
(C) Label · (D) Repetitive

51) By using which of the following statements the following
statements in a_ body are skipped and the control is
transferred at the first statement after the switch statement?
(A). continue 
(C) break
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(B) default
(D} for 
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52) Which logical operator returns t_rue only ifits operands are
different ( one true �nd one false) and false ptherwise?.
(A) XOR (13) bR
(C) AND . (D) NOT - .

_ 53) Which ,of the following is a proper option for th� statement 
"ls A:not equal to B"? · 
(A) A<>B -{B) .A*�

.. (C) A NOTB ·. _ . '(D) A!'= B .

54) If a� 12.5 and b = 7.2, then afterexecuti�g-a%b, what will
. be the remainder?

(A) 1
(C) 5.0

(B) ·5.3
(D) 1.22

55) Which symbol is used to begillsingle-line comment?
(A)·/* ... */

- (C) II

·(B) J ** ... */
(D) \\

56) Which of the following is 'not a proper example of Hexa ·
decimal number?· · 

. . . . 

(A)· OXFF7A
(C) OX532D

(B).·_- OX39A2 
{D) OABC 

57) How. many basic {primitive) data types are supported in
Java?
(A) ·-2 -· 
(C). 8 -· .. . 

(B) 4-·
· (D) 16

_ 58) What is the name of the data· structure, where al r in.stances·· 
of class are allocated memory? · 
(A) Hea\' (B) . NM
(C) Garbage Collector (D) -Instance
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· 59) Whichofth� following options is provided by Java, mainly
to perfonrt initializing actions? 
(A) Constructors
(C) Class

(B). O_bject 
(D). Method 

60) Which level ofprotection is used to allow the access only
· · to subclasses or to sha·re with the methods declared as ·

"friend"?
. (A) Private : 
· (C) Package

(B) Public
(D). Protected .

61) · Which methods operate on a particular ob
j

ect or affect that 
object? .

. . (A) C'la�s me:thods , · (B). Local methods
(D) Global methods

62) 

(C) Instance niethods 
. . ; . . 

Which method is _u�ed, when we wantto allow other
· methods to read only the data value?
. (A) setter'' (B) ·. getter
· (C) void (D) return

. . 

63) Which kind of relationship is estabfished between classes
by composition and aggregation?

·.(A). A-kind-of (B) has-a -
{C) A�pai-t-of (D) IS-a .

64) Which prote�tion level provides data encapsulation?·
(A) Private , · (B)_ Protected 
(C) Public · (D) Package

65) Which symbol is used to" show ,inheritance between two
classes? 

. . . 

(A) Empty diamon�f: .
(B) Filled diamon4
( C) · The arrow poinis from superclass to -subclass
(D) The arrow points from subclass to superclass
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66) . Which is the proper statemen t to invoke display {) .method 
·of superclass?
(A) display {)
(C) super.display ()

(B) display.super ( -)
(D) show.display ( )

. . 

67) ·When we write class in Java, it is made up ofwhich two
. components?
· (A) · -proc�d�re and behaviour
(B.) attributes and behaviour·
(C). variable and values . ·

I • 

(D) main () method andC:onstructor

68) Which kind of �ariable is a.variable representing a collection
of homogeneous type of elements?

· (A) Local (B) Instance
(C) Global (D) Array

. . 
. 

69) Which of th� following options is. not proper for array·

70) 

71) 

declaration :with inttial values? ·. r .

. . . . 

(A) int marks.[3J= new marks {90, 70, 77};
(B) int marks LT= {90, 70, 77};
(C) int[] marks - {90, 70, 71};.
(D) int marks-[]= {90, 80, 70, 60};

How many· integer values will ·be . stored in the· following 
· array?.

. . . 

· int marks[] f] = new int [4][4];
(A) 8 (B) 64
(C) 16 (D) 4

\ . .

Which of the following constructors creates an object that 
refers to tp.e literal specified in argument? 
(A) string_(string literal). (B) string (char literal) ·

· (C) string (string strobj) (D) string (char ary [])
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72) Whfoh of the following methods returns true if invoking
string· is same as str?

73) 

74) 

75) 

. (A)' boolean compare to (string str) 
(B) . boolean equals (string str) ··
(C) int compare to (str stririg)
(D) int equals (string str)

Which of the following methods· returns a st�ing after · 
· appending str with the invoking stririg?-1 
(A) string to Lower case ( ) (B) -string to Upper case ( )
· (C) string conc.at (string sir) (D) intlength (} · · 

Which command is used t� assign value 5 to all elements of . · . ·
list array? -· . 
(A) sort (1!st, 5) (B) sort (list, l, 7, 5)

: (C) f ill ( list,)_, 6, 5) (D) fiH(list, 5) 

Which method of date class sets new date and time of an 
object usfng elapsed time? . · 

(A) void setTime (long elapse_dTime)
(B) longgetThne ()
(C) Date (long elapsedTime)
(D) .Date (}

76) If calendar is an ()bject of calendar class, then which of the
following commands will setthe date· to 20?
{A) calendar.get ( calendar.DATE, 20)
(B) calendar.set (�alendar.DATE, 20)
(C) get._�alendar ( calendar.DATE, 20)
(D) set�alendar ( calendar.DATE, 20)

77) What is the value of December month in the. MONTH
constant of calendar dass?
(A) l2
(C) 11

(.B) 1 
(0) 0
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78) Syntax errpr" in the program is considered as which kirid of
error?-,
(A) Compilation error .
{C) Variable error

(B) Run time.error
· (D) · Printing error

.. 79) Which kind of exception will be generated, when an attempt · , 
.. to convert ·string H> a number .type is done? · · · 

. . . 

(A) Arithmetic:Exception
.·(B). · NullPointerException .
( C) · · 'Printer! OException
(D) NumberFormatExceptio11 · .

80) · Which of the following block� is kil�wn as exception-
. handler? · · ' · 

(A) try block. '.'
· (C) catch bl.ock .· .

(8) main () m.ethod , .
(D) throw _block. -

. . • 
"t.' 

81) Whai wiU happen when a ,ry · block cJoes n6t' gen�rate an
·; Exception and yotJ have included multiple c�tch blocks·? ·_ 

(A) They aU execute
_· (B). Onlythe first matching one executes 
(C) No catch block ex�cutes _·_ ._ .

· · (D) · Only the first catch block execut�s
. . 

82) Which ofthe follo�ing blocks con,tains :the code that may
giyerise to one or more exceptions?· i:
(A) throw (B) throws
(C) . finally ·_· (D) .try

83) In the field of Computer Science, \vhich of the_ f6Ilowing
lines indicates that the compilation of program is not 
successful? 
(A) Exit Code : .1
(C). Exit Code: -1

TEE46 331(E) / A 

(B) · Exit Code : 0 ·
. (D) Exit: 1
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84) Which kind of files can be data Jiles that contain facts such
�s pay-roll file,program files or application files7

. (A) · Binaty files _ (B) Text files 
(C) Image files . . (D) AH(A), (B), (.C) 

, 85) Which. of the following is not a.proper constructor of file 

·.86)

87) 

class? 
. (A) File (string path) 
·(B) File (directory�path).

· (C) File (stri'ng directory_ path, string file �name)
(D) File (file directory, �t�ing file _name).

\ . . ,-" 

Which kind of files are used:to store variables like integer,
double or boolean into a file arid also _to store arrays and 
objects? 
(A) Tex(file · · · · 
( C) Image file 

(B) I<omp�Zer file
(D) Binaty. file

. . 

Which �ind of exception will be thrown by writerdass?
(A) Fil�NotFoundException
(B) ArithmeticExceptiori

--(C) IOException
(D). NullPointerExcep�ion

88) · Which of the following methods isu$ed to wr'ite aformatted
string to the console's output stream using the specified ..
fortnat siring and arguments?

. . . 
rr .

, (A)· Console printf(string format, object args)
(B) Char read Pa'ssword ( )

. .  

. (C) Char read Console ( )
· (D) String (Object args) · -

. . . 
. 

89) Whic�.method of s.cai:inercl�ss returns the n�xttoken?
' (A) · irit nextlnt (:) (8) String has Next ( )
(C) String next() (D) .boolean has Next ()
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90) Find correctopti<?n· from the foll9wing: ·.
A . . B 

(i) Line break command . (p) · \ (backslash)
inLaTe�

(ii) Comment character in · (q) [ J ( square brackets)
LaTex •

(iii) Starting•character of
LaTeX command

(iv) · Brackets used for
optional arguments in

.. ·. LaTex.

(r) ·\\.

· (A) (i) ➔ (s), (ii)➔ (q), (iii)➔ (p),(iv)'➔ (r)
(B) (i)➔{r),(ii)➔ (s),(iii) ➔ (p), (iv)➔ (q) •.·. ·

.. · (C) (i)➔ (p),.(i1) ➔ (r);.(iii)� (q), (iv)➔{s) ·
(0) �i) ➔ (q), (ii)➔ (p), (iii) ➔{r)� (iv)➔_js)

·. 91) Which package of La Tex has special features for including
programm}ng code within the .document? 

· (A) easylist (B) amsrrtath
(C) geometry (D) listings

. . . . .' . 

92) After which command of LaTex, all chapters are treated as:
·· · appendices and it is to be used only once? · · 

. . . . .·.· .. . ,· .. . Q · (A) \setcounter · (B) · \tableofcontents 
(C) \mainmatter .· (I?). .\�ppendix 

93) Which of.the following LaTex ��riltruinds is ·used to insert·· 
mathematical symbol 'i:; i� the documerit? . 

(A) \subset . . (B). \in .
' . -

(C) \notin , (D) \ri�� · 
. .. � � .... ' -· ' 

_. .. ·• 

_94) What is the full form ofCTAN? . . .· · 
. . 

.(A) Comprehensive Tex ,f\rchitech Network 
(B) The Comprehensive Tex A�chNe 'Network · .
(C) The ComputerizedTexArchiveNetwork '
(D} The Comprehensive Tex Archive Numerology
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95) W�ich of the following document class is used for writing
letters?
(A) · 1etter
(C) book

(B) artide
(D) beamer -

96) Whatwill be the output, if following command sequence is
given in R software?
> a� 10
> b -+-• 30
>a* b
(A) Error (B) 10
(C) 300 (D) 40

, . , 

9.7) Which meriui� -µsed to.start VL,C Me<;lia Player? -• _-
(A) Med_ia � Open File ... _ - -
(B) Media➔ Open Directory ...

_ · (C) Media➔ Playlist -
·• (D) Application� ➔ Sound & Video

98) In Archive Manag;er, which _optiori is used to create new
archive? · · 
(A) Archive· 
{C) Extract 

"(B) Compress
(D) B�ck•-

99)- Which desktop p.ropuctof Rational Plan-,allows links
betweenta�ks peqain,ing lQ different projects, analyzes all,

·. our projects 4�tij c;tTTd creates a projectp6rtfolio view? -
(A) · Rationid-Pl�n Single (BY Rational Plan Viewer
(C) Ration&l Plan Multi (D) Skype -

, . 

]0-0)lnBkype, which buttpn shoµJd be clicked afte.r giving Skype
n�me and .password in the text box?
(A) Sign in _ - - (B) Log in _ ·
(C) New User . (D) Enter Skype
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